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1. WELCOME TO SEAVUS DROPMIND™ 

 

 

 

1.1 INTRODUCTION 

Seavus DropMind™ is dynamic and exciting mind mapping software tool for visual 
thinking, brainstorming, planning and organizing in real time. Seavus DropMind™ helps 
you map out information and improve your memorizing process, boost productivity and 
creativity. It is great for solving problems easier, improve communication and make plans 
more quickly and creatively.  

Whether you are Microsoft®, Mac or Linux user - it doesn‟t matter. Seavus DropMind™ is 
a platform friendly mind mapping solution. When you choose Desktop Seavus 
DropMind™, you are free to choose.  

With its smooth usability and highly interactive interface it really saves time, energy and 
effort and improves every aspect of your work. Seavus DropMind™ allows users to 
capture all important information on a simple, easy-to-use, cross-platform friendly mind 
map. 

This exiting mind mapping tool guides you to clarify your thinking. The flow of your 
thoughts creates worth and valuable never-ending story. Seavus DropMind™ helps you 
make your story streamlined in an intuitive and powerful mind map and stimulate your 
visual thinking. 

 



                                                                                                             Seavus DropMind™ Desktop - Product Overview 

 
 

 
                                                                                                                      © 2009 Seavus Group. All rights reserved.  

3 

Now you can create meaningful mind maps and have fun at the same time. Type your idea 
as you think and visualize your mind in a second. It provides simplicity and easiness to 
your visual thinking process. 

Seavus DropMind™ makes the most of the core mind mapping functionalities with a single 
click navigation and very intuitive user interface. It offers a selection of features that 
provides you with full advantage of the logical way of thinking. Words are not as powerful 
on their own as when you take the time to draw them into images. 

The powerful combination of a web-based and a desktop tool, enables you to create your 
maps while offline and then publish it and collaborate with your community as well as 
synchronies changes. Now it is really easy to create a collaborative environment in your 
team. 
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2 SEAVUS DROPMIND™ FUNCTIONALITIES 

2.1 BASIC FUNCTIONALITY 

The "DropMind™ Button" is the place to click when you're looking to manage your maps. 

This is the place to open, save, and print your maps, synchronies your desktop and web 
maps, import and export maps to an appropriate format file.  

 

2.1.1 NEW MAP 

To start a new map you should use the “New” function which will allow you to open a new 
map from: ”Default Map”, “From Existing Map” and ”From Templates or Style”. 

If you click directly on “New”, a new map is opened.  If there is already one or more maps 
opened, the new map is opened in another tab.  

 

2.1.2 OPEN MAP 

When you want to open an already created map you use this function. As a pop-up 
window appears from where you can choose the location from which an already saved 
map will be opened. Only .dmm file format is supported.  

On a “mouse-over” on “Open”, the recently used (created and opened) maps will be shown 
with their names. The limit is showing up to 10 maps in “Recent Maps”.  

 

2.1.3 IMPORT 

The Import function allows import from several file formats: 

 Import from Mindjet MindManager 

 Import from XMind  

 Import from FreeMind 

 Import map from Word Outline Document 
 

2.1.4 SAVE MAP 

“Save” appears under the “DropMind Button”. This submenu contains 4 options: “Save”, 
“Save As”, “Save As Template” and “Save All”. 

 

2.1.5 SAVE 

When you are done with the editing of the map, you are ready to “Save” the map. With 
Seavus DropMind™ you can save the map in several ways 

 

 Save As 
When you click “Save As”, and the map is already saved, the same procedure exists as 
saving a completely new map. Supported file format is .dmm.  
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 Save As Template 
When you click “Save As Template”, and the map is already saved, the same procedure 
exists as saving a completely new map. Supported file format is .dmm. “Save As 
Template” enables you to use the saved map as a base for creating new maps. 
 

 Save All 
When you click “Save All”, all currently opened maps are to be saved.  
 
 

2.1.6 PRINT MAP 

If you would like to share the map as a printed material, you use the “Print” options. Before 
printing you can have a preview of the map, as well as the page set up to prepare for 
printing. 
 
 

2.1.7 INTEGRATION 

Now we get to the fun and exciting synchronization part of the functionalities.  

This set of options enables the integration between the desktop and web version of 
Seavus DropMind™. From here you can upload maps created in the desktop version to 
the web version and you can download maps created with the web version to the desktop 
version. It also enables you to synchronize the desktop Seavus DropMind™ maps with the 
web version Seavus DropMind™ maps. In order to use this set of options you will have to 
posses Seavus DropMind™ web account. 

 
 

2.1.8 SEND 

By clicking on the Send submenu you may choose the option “Send Map as email 
attachment. The currently opened map will be send to the recipient of your choice trough 
the default email client on the computer.  

 
 

2.1.9 EXPORT MAP 

As you are able to import maps, Seavus DropMind™ allows you to export maps in several 
file formats. 

 Export Map as PDF Document 

 Export Map as image 

 Export Map as Word Document 

 Export Map as Rich Text Document 

 Export Map as PowerPoint Presentation 

 Export Map as HTML  

 Export Map as XML 

 Export map to FreeMind 
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2.1.10 CLOSE MAP 

After you have done all you needed to do for your mind mapping tasks, it is time to close 
the map. Seavus DropMind™ will surely remind you to save the map if needed, before you 
close. 

 
 
 

2.2 SPECIAL FUNCTIONALITIES  

2.2.1 SPELL CHECKER 

The Spell Checker will provide help regarding your spelling after you choose the 
appropriate language for the text in you map. It is a great option to save time, while you 
are creating your maps. 

 

2.2.2 GRAPHICAL USER INTERFACE 

Seavus DropMind™ provides you with the option to set your interface the most suitable 
way for you.  Make the proper changes in the users interface enjoy the application in your 
own way. Now, DropMind is available in English, Japanese, German, French and Spanish. 

 

2.2.3 SHORTCUTS 

Once more, Seavus DropMind™ will give you the chance to customize the application to 
the most suitable way for you. Now you can set the shortcuts for the most common used 
actions in DropMind, such as the creation of sub-topic or sibling topic, that will save you 
time and clicks. 

 

2.2.4 PROXY SETTINGS 

The “Proxy Settings” menu enables you to choose the way your application connects to 
the Internet. The default marked option is “Detect Proxy Automatically”. If you leave this 
option marked the application will copy the proxy settings set in Internet Explorer. You can 
also set the proxy settings manually from here. The proxy settings are needed for the 
Integration options to function properly. You must have Internet access to use the 
Integration options and to properly activate the application. 

 

2.2.5 ACTIVATE 

When you click on the Activate option, the activation window will appear. In here you can 
enter the Registration code and to change your License type. You can enter New Key for 
activation, update an existing Activation key or Reactivate the application with an existing 
key. 

 

 

 



                                                                                                             Seavus DropMind™ Desktop - Product Overview 

 
 

 
                                                                                                                      © 2009 Seavus Group. All rights reserved.  

7 

3 ADDITIONAL FUNCTIONALITIES FOR YOU 

3.1 THE QUICK ACCESS TOOLBAR 

The "Quick Access Toolbar" allows you to quickly access commands that you frequently 
use. For example, printing, saving, and opening new maps are some of the most popular 
functions in Seavus DropMind™. With this toolbar you're just one-click away from the 
commands you most often use. Here you will find the following functions: Undo, Redo, 
New Default Map, Open Map, Save Map, Print Map, Print Preview and Close Map. 

 
 
 

3.2 THE COMMAND TABS 

3.2.1 THE “HOME” TAB 

The "Home" tab contains the most popular commands. They are organized for ease of use 
and are categorized into groups. Here you can find the “Clipboard”, “Insert”, “Topic 
Elements”, “Formatting” and “Editing” groups.  

3.2.2 THE "INSERT" TAB 

From the "Insert" tab, you can insert topics, relationships, borders, notes, hyperlinks, icons 
and images.   

 

3.2.2.1 "Insert" group  

 Insert Sibling Topic 

Sibling topic refers to a same level topic. You can add as much sibling topics as you want. 
You can not add sibling topic to the Central Topic and to floating topics.  

Whenever a sibling topic is added, you can immediately start writing text inside. There is 
no limit on characters added in topics. 

 

 Insert Subtopic 

By clicking on “Subtopic” button from menu, new subtopic of the selected topic is added. 

You can add as much subtopics as you want. This Whenever a subtopic is added, you can 
immediately start writing text inside. There is no limit on characters added in topics. 

 

 Insert Parent Topic 

By clicking on “Parent Topic” button, a parent topic is put between the selected topic and 
the previous topic which was connected to the selected topic. 
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 Insert Floating Topic 

This menu button allows you to add a topic in the map that is floating, meaning it has no 
relationship to topics under the Central Topic. It has the same properties as any other 
topic, except that a sibling topic can not be added from floating topic.  

Floating topic can have subtopics and callouts.     

Floating topics can be moved on the map space. If you want, you can attach the floating 
topic somewhere in the map, so that it will no longer be a floating topic.  

Whenever a floating topic is added, you can immediately start writing text inside. There is 
no limit on characters added in topics. 

 

 Insert Key Topic 

You will be able to label a node as a key node when you click the key node button. These 
key nodes are the key points in the map. These nodes are uniquely differentiated by the 
other nodes. Key nodes are differentiated from other nodes by the border. They have 
„bolder‟ border. Every node (central, floating) can become key node. You can click on the 
same button if you want to make a key node normal node. When key node is selected, the 
“Key Topic” button shall be shown as clicked (selected).  

 

 Insert Callout 

Callout topic is a descriptive topic and has the same properties as any other topic. It can 
be added to any topic except the Central Topic. By default, it is placed above the selected 
topic. Also, you can add callout to external relationships when it is placed in the centre of 
the relationship.  

Whenever a callout is added, you can immediately start writing text inside. There is limit on 
characters added in topics. 

 

 Insert Relationship 

By button click from menu, the mouse pointer changes its form indicating that two topic 
have to be selected in order to put an external relationship between them. You click one 
topic and then click another one placing an external relationship between them with an 
arrow pointing from the first to the second topic, by default. You can put two different 
external relationships to the same two topics. There is no limitation for number of external 
relationships per map.  

In case when the external relationship button form menu is selected and you click on an 
empty map space or on menu, the function is deselected. External relationship is selected 
when clicking on the appropriate button. In case when you select appropriate button from 
menu, select topic and then drop mouse, or click anything else, nothing happens, the 
mouse pointer gets its default form. In case you selected the button for inserting 
relationship from menu, by clicking on it again, the external relationship function remains 
since it is already selected.  
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 Insert Boundary 

Boundaries are used to group topics and subtopics with an outline surrounding them. You 
select the topic whose subtopics you want to group with the boundary. Click “Boundary” 
button from menu and a boundary with default boundary shape is inserted around the 
selected topic and all its subtopics. You can add boundaries within boundaries.  

 

3.2.2.2 "Topic Elements" group  

 Notes 
You can add notes to any topic. Icon for notes is placed inside topics. There can be only 
one note per topic.  
 

 Hyperlink 
You can add hyperlink to any topic. One hyperlink per topic can be added. 
 

 Attach 

By clicking on the Attach option, you can add attachments to the currently selected topic. 
You can attach any type of file to the topic. You can remove the attachment from the menu 
or open the manage attachment window. 
 

 Icon, Images 
You can add icons and images to topics. You can use the available icons from the icon 
library appearing in the right menu. You insert mages from the Library or from a file on 
your computer. Supported image formats are: .svg, .svgz. .png, .bmp, .gif, .jpg, .jpeg. 
 

 Date&Time 

You can add date and time to the topics. When you click on the Date&Time button a 
calendar will appear which allows you to chose the date and time that you wish to apply to 
the topic. 

 

 Alerts 

Alerts are a part of the “Insert” tab and they can be added on each topic. You can set the 
alerts to have a recurrence on daily, weekly, monthly or yearly bases, Additionally the 
feature allows to set reminders. The alert is presented as an appropriate icon in the bottom 
right corner of the topic. 

 

 Task Info 

Task Info properties of a topic can be defined also. These properties allow setting of the 
start date, finish date, duration, priority, % complete and resources. 
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3.2.2.3 "Editing" group of functionalities 

 Find and Replace 
You can find and replace text used inside topics. To quickly search for every occurrence of 
a specific word or phrase you click the “Find” drop-down menu and click “Find”. A pop-up 
window for find and replace appears. 
 

  Advanced Search 
Advanced search is a powerful built in search engine in desktop Seavus DropMind™. With 
this option you can search trough multiple levels of the map. 
 

 Remove 
 “Remove” option usually refers to the selected object, depending if it is an image, topic or 
a relationship. On a click of the button a drop-down list appears with all the available 
functionalities for the appropriate object. 
 

3.2.2.4 Map Parts 

“Map Parts”  provides you with the ability to save part of a map you‟ve created for easy re-
use. The saved map part is shown in the right side vertical panel, the “Library”. 
With a right-click on the saved map part in the list, you can “Insert as New Topic”, “Modify”, 
“Delete” or “Rename” the map part. 
When you choose to modify a map part, click the “Modify” button after you right-click on a 
map. The map part editor will open in another tab. Each change you made there will be 
saved in the “Map Part” library.  
 

3.2.3 THE "FORMAT" TAB 

 

3.2.3.1 "Topics" group  

 Topic Shape 
Seavus DropMind™ will provide you with the ability to change the topic shape. You need 
to note that callout topics have different shapes than normal topics.           

You can choose a topic shape from the shapes library to be applied to the selected topic.  

Additionally you can change the topic parameters with the “Format Topic” option from 
drop-down menu. 

 

 Import Shape 
Seavus DropMind™ allows you to import shapes and place them in you application as “My 
Imported Shapes” through this function. 
 

 Icon Placement 

By default, icons will be placed before the text in topics. By clicking on the appropriate 
button from menu, you can place icon under, above, before or after the text. 

 
 

 Image Placement 
As you are able to pace Icons on the required position, Seavus DropMind™ allows you to 
place Images the same way. 
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3.2.3.2 "Objects" group  

 Relationship Shape 
You can change relationship‟s begin and end style by choosing from the available options 
in the drop-down menu when “Relationship Shape”  

By clicking on the “Format Relationship” option from drop-down menu, a pop-up window 
appears allowing you to change the relationship format. 

 

 Boundary Shape 
You can change boundary‟s outline by choosing from the available options in the drop-
down menu when “Boundary Shape” is clicked. 

By clicking on the “Format Boundary” option from drop-down menu, a pop-up window 
appears allowing you to change the boundary format. 

 

 Line 
Line refers to the line of the relationships and boundaries. You can change relationships‟ 
and boundaries line style and weight by choosing from the available options in the drop-
down menu when “Line” is clicked. 
 

3.2.3.3 "Formatting" group  

Here you can change text‟s font family, change text style by making it bold, italic, underline 
or strikethrough, text size and change the text color. Also you can align your text. 
Additionally, from here you set the topic border color and topic fill color. 

 

3.2.3.4 "Layout” group  

 Numbering 
The numbering button enables you to number map topics, placing numbers before the 
topic text. When a new topic is added it is automatically numbered. If you want to re-order 
topics, they will change the numbers accordingly.  
 

3.2.3.5 "Background" group 

 Background Color 
You can change the background color by clicking on the “Color” drop-down menu and 
choosing the wanted color. 
When clicking on “More colors” a pop-up window appears allowing you to customize the 
color to be used as background color. 
 

 Background Pattern 
By clicking on “Pattern”, the patterns library appears as right menu from where you can 
choose a pattern to be applied to the background. 
 

 Format Background  
By clicking on the “Format Background” button, a pop-up window appears allowing you to 
change the background format 
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3.2.3.6 "Map" group   

 Map Color 
You can change the color of the whole map by choosing a color to apply to the whole map 
from the list. The color is applied by the following rule: central topic has the blue color 
(always), level one has darker color, level 2 lighter and level 3 the lightest (the other levels 
have the level 3 color) depending on the map color chosen from the menu. By selecting 
from the “Formatting” group, from drop-down menu you will be able to choose from 
predefined colors which will be applied on the whole map.  
 

 Map Styles 
Seavus DropMind™ provides several available map styles you can choose from. You can 
change the style of an already created map, or a completely new map.  
 

 Topic Styles 
Using “Topic Style” functionality you can customize preferred topic style, save it in the 
“library” and apply it to other topics. You will be able to create a new style from the 
selected topic and add it in the topic styles „library‟. Afterwards you can choose from 
different topic styles you‟ve created and apply them on topics. These include the topic font, 
shape and color, alignment, size and margins, and subtopics layout. 
 
 

3.2.4 THE "VIEW" TAB 

 

3.2.4.1 Outline button 

Through the “Outline” function Seavus DropMind™ allows you to edit the names of the 
topics in the outline window by double clicking on them. The changes are automatically 
shown on the map, and vice versa, all map changes are shown in the outline window. One 
click selects the row.  

 

3.2.4.2 "Detail" group  

 Details 
Now you can chose the level of details on the map that you would like to view. When you 
click on the Details button you will be able to choose the level of the detail on the map. 
Level 1 will present only the central topic and the main topics, all the other child topics and 
sub-topics will be collapsed. You can chose to see level 3 and you can again expand all 
levels of the topics by clicking on the “All” levels option from the menu. 
 

 Show Branch Alone\Show All Branches 
You can select a topic and its sub-topics, this option will enable you to see only the 
selected topic and its sub-topics on the map. All the other topics including the central topic 
will be hidden. The only shown branch will be the selected one. By clicking on the Show all 
branches you will return to the previous view, i.e. the whole map will be shown again. 
 

 Expand/ Collapse 
On a button click from menu, only the selected topic shall be shown when it is collapsed 
and all its subtopics are shown when it is expanded.  
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 Select Branch 
To select a Branch of the map you just have to click on the “Select Branch” button from 
menu, and  the selected topic and all its subtopics are selected. If the selected topic 
doesn‟t have subtopics, or if the central topic is selected, this button is disabled. 
 

3.2.4.3 Map group 

  Balance Map 
To balance the map and to have the topics automatically distributed left and right from the 
main topic to visually balance the map use the “Balance Map” option. Nodes shall be 
symmetrically placed in position to the main node. This is applied to the whole map, 
whenever any node of the map is selected.  
 

 Focus on Topic 
By click on this button, the selected topic will be shown on the screen. Focus means to 
display the currently selected topic on the screen. 
 

 Center Map 
By clicking on this button, the Central Topic (and whole map appropriately) is automatically 
placed in the center of the screen. This is applied to the central topic, nevertheless which 
topic of the map is selected. 

 

3.2.4.4 "Filter" group  

Filtering is a convenient way to view only a subset of the topics on a map. With this 
features you can eliminate the topic that is not currently of interest, but remains valid 
content. The filtering feature provides a set of filtering options Show Selected Topic, Hide 
Selected Topic, Advanced Filter and Remove Filter 

 

3.2.4.5 "Zoom" group  

 Zoom In/ Zoom Out 
Zoom In or Zoom Out on you map by minimum of10% and maximum of 400%. 
 

 Fit Map 
By clicking on this button from menu, the whole map shall be shown on the screen. The 
map is accordingly zoomed in or out to be fitted on the screen. 
 
 

3.2.5 PRESENTATION TAB 

In this tab are the options that allow you to create presentation with Seavus DropMind™.  

 

3.2.5.1  Create group 

 Take snapshot 
By clicking on the Take snapshot button, a snapshot of the selected topic and all his sub-
topics will be taken and shown in the Presentation slides window. 
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  Generate snapshots 
This option enables the automatic generation of snapshots. Snapshots from every topic 
will be taken and shown in the Presentation slides window.  
 

  Stop 

When you click the Stop button you will stop the automatic generation of snapshots. 

 

3.2.5.2 Slideshow group 

 Play button 
By clicking on the “Play” button, a full screen appears, showing a slide show from the 
presentation slides. A button in the right side appears for “Next Slide” and on the left side 
for “Previous Slide”. To exit the slide show, you should press “Esc”. When you go at the 
top of each slide, a „hidden‟ menu is appears with “Close” button to close the slide show, 
and “Show/Hide Notes” button to show or hide the notes. The option to view presentation 
with notes refers to show the notes of the main topic on the slide. 
 
 

3.2.5.3  Manage group 

 Show Map 
When you click on the “Show map” button you will exit from the slide preview. When you 
click on a snapshot in the “Presentation slides” window a preview of the select slide will be 
shown on the place of the map. The “Show map” button returns you to the map. 
 

 Export 
When you click on the Export button all the snapshots will be exported in a zip archive 
(each slide will be exported as image in the archive). A pop-up window will appear asking 
you to choose the location where the archive will be saved. 
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4 TABBED DOCUMENTS 

Seavus DropMind™ incorporates tabbed document feature. Seavus DropMind™ provides 
you with tabs representing each of your open maps. One tab represents one map file. You 
may quickly switch between open maps by clicking on the corresponding tab. Map name is 
shown on each tab. When there are already opened maps, new map is opened in a new 
tab. 
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5 GETTING HELP 

If you need help, just click on the question mark  and a "Help" menu will pop up.  You 
can either browse through Seavus DropMind™ "Help" contents, or type in some keywords 
in the "Search" field to find the answers you're looking for. 

 



                                                                                                             Seavus DropMind™ Desktop - Product Overview 

 
 

 
                                                                                                                      © 2009 Seavus Group. All rights reserved.  

17 

6 TECHNICAL BACKGROUND INFORMATION 

6.1 SYSTEM REQUIREMENTS 

Recommended System Requirements: 

 

Windows: 

 Intel® 1.4 GHz processor or equivalent 

 256MB of RAM (512MB recommended) 

 40 MB of available hard disk space (during installation) 

 1024x768 @16-bit color (1280x800 @24-bit color or higher recommended) 

 

Mac: 

 Intel processor (Power PC not supported) 

 Mac OS X v10.4.8 or higher (Mac OS X v10.4.11 or higher recommended) 

 90 MB of available hard disk space (during installation) 

 1024x768 @16-bit color (1280x800 @24-bit color or higher recommended) 

 

Linux: 

 Intel® 1.4 GHz processor or equivalent 

 X11 Desktop Environments 

 80 MB of available hard disk space (during installation) 

 1024x768 @16-bit color (1280x800 @24-bit color or higher recommended) 
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7 LICENSING AND DISTRIBUTION 

 One year license of fully functional desktop Seavus DropMind™ 

 Lifetime fully functional desktop Seavus DropMind™  

 Academic license 
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8  CUSTOMER SUPPORT CENTRE 

Seavus has a dedicated Customer Support Centre that is available for any kind of 

help that customers may need related to Seavus DropMind™. 

 

You can contact us through: 

 

 contact form on the web,available at http://dropmind.com/CustomerSupportCenter.aspx 

 over e-mail at support@dropmind.com 

 via telephone on:  

888-5SEAVUS (toll free) – for USA 

+46 40 578 883 or +389 2 3094 061 for Europe 

 

Our standard working hours are Mon-Fri., 8:00am - 12:00 Midnight CET. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Seavus Group 

Skeppsbron 5  

211 10 Malmoe, Sweden  

Phone: + 46 (0) 40-300-940  

Fax:     + 46 (0) 40-300-941    

Email: support@dropmind.com   

URL: www.desktop.dropmind.com 

 
All documents prepared or furnished by Seavus Group and the copyright therein shall remain the property of Seavus Group. 
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